
BASIC SEVEN (7) 

Inserting Data in Excel 

Inserting data means adding new values, rows, columns, or cells into a worksheet. 

Ways to Insert Data in Excel: 

• Typing Directly: Click on a cell and type the data. Press Enter to move to the next row or Tab to move to the 

next column. 
• Inserting Rows or Columns: 

1. Right-click on a row number or column letter. 
2. Select Insert from the menu. 
3. A new row or column will appear above or to the left. 

• Inserting a Cell: 
1. Click on a cell. 
2. Go to the Home tab → Click Insert → Choose Insert Cells. 

Example: If a list has student names in A1:A5, inserting a new row in between will shift the existing data downward. 

 

Selecting Data in Excel 

Selecting data allows you to format, delete, or move it. 

Ways to Select Data: 

• Single Cell: Click on the cell. 
• Entire Row: Click the row number (e.g., 3). 
• Entire Column: Click the column letter (e.g., B). 
• Multiple Cells: Click and drag over a range (e.g., A1:C5). 
• Select All: Press Ctrl + A. 

Example: Selecting all students' scores in a worksheet before formatting them. 

Deleting Data in Excel 

Deleting removes unwanted values, rows, columns, or cells. 

Ways to Delete Data: 

• Delete Cell Contents Only: 
o Click on a cell and press Delete on the keyboard. 

• Delete an Entire Row or Column: 
1. Select the row/column. 
2. Right-click → Choose Delete. 
3. The remaining data shifts up or left. 

• Delete Specific Cells: 
o Select a cell → Click Delete on the Home tab → Choose how to shift the data. 

Example: Deleting a student’s record from a table shifts the other records up. 



Moving Data in Excel 

Moving data helps in organizing or restructuring worksheets. 

Ways to Move Data: 

• Cut and Paste (Ctrl + X → Ctrl + V): 
1. Select the data. 
2. Press Ctrl + X (Cut). 
3. Click the destination cell. 
4. Press Ctrl + V (Paste). 

• Drag and Drop: 
1. Click and hold the selected data. 
2. Drag it to the new location. 
3. Release the mouse button. 

• Using "Move or Copy" Feature: 
o Right-click on a sheet tab → Choose Move or Copy to transfer it to another workbook. 

Example: Moving a student’s score from one sheet to another. 

Setting Cell Data Types in MS Excel 

In Microsoft Excel, cells can store different types of data, such as numbers, text, dates, and currency. To ensure 

accurate calculations and proper formatting, it is important to set the correct cell data type. 

What is a Cell Data Type? 

A cell data type defines how Excel interprets and displays the values in a cell. For example: 

• A number can be displayed as a regular number, a currency, or a percentage. 
• A date can be shown in different formats like DD/MM/YYYY or Month Day, Year. 
• Text remains as it is and does not get calculated. 

How to Set and Modify the Cell Data Type 

Method 1: Using the "Number Format" Drop-down 

1. Select the cell or range of cells. 
2. Go to the Home tab. 
3. Locate the Number Format section in the toolbar. 
4. Click the drop-down menu and choose a format (e.g., Number, Currency, Date). 

Method 2: Using the "Format Cells" Dialog Box 

1. Select the cell(s). 
2. Right-click and choose Format Cells. 
3. In the Number tab, select the desired category (General, Number, Currency, etc.). 
4. Click OK to apply the format. 

General (Default Format) 

• This is the default format in Excel. 
• It does not apply specific formatting rules. 

• Example: Entering 12345 will display as 12345. 



2. Number 

• Used for numeric values without currency symbols. 

• Can include decimal places. 
• Example: 12345.67 → Can be set to show 12,345.67 (with thousands separator). 

3. Currency 

• Used to display monetary values with a currency symbol (e.g., $, €, ₵). 
• Example: 1000 → Can be formatted as $1,000.00. 

4. Accounting 

• Similar to currency but aligns symbols and decimals for easier reading. 
• Example: 1000 → Can be formatted as ₵ 1,000.00 with proper spacing. 

5. Date 

• Formats numbers as dates. 

• Example: 01/01/2024 → Can be displayed as January 1, 2024 or 01-Jan-24. 

6. Time 

• Displays time values in different formats. 

• Example: 14:30 → Can be shown as 2:30 PM. 

7. Percentage 

• Converts numbers into percentages. 
• Example: 0.5 → Becomes 50%. 

8. Text 

• Treats numbers as text (useful for phone numbers or ID numbers). 
• Example: 0501234567 → Remains as entered, without scientific notation. 

9. Scientific (Exponential Notation) 

• Used for very large or very small numbers. 
• Example: 123456789 → Can be displayed as 1.23E+08. 

10. Fraction 

• Displays numbers as fractions. 

• Example: 0.75 → Can be shown as 3/4. 

Practical Activity: Changing Cell Formats 

Step-by-Step Exercise 

1. Enter different types of data in Excel: 
o A number: 1234 
o A currency value: 1000 
o A date: 01/01/2024 
o A time: 14:45 



o A percentage: 0.85 = 85% 
2. Select each cell and change its format using "Format Cells". 
3. Observe how Excel changes the display based on the selected format. 

Using the Autofill Function in MS Excel 

What is Autofill? 

Autofill is a tool in Microsoft Excel that helps you quickly fill a series of numbers, dates, or text in a 
worksheet without typing everything one by one. 

 

How to Use Autofill: 

1. Type the first and second item 
o Example: Type "Monday", “Tuesday” in a cell. 

2. Select the two cells 
3. Place the mouse pointer on the small square at the right-bottom corner (fill handle) 

4. Click and drag the fill handle down to the last cell you want to fill 

 

Uses of Autofill: 

• Functions/formulas: = A2*5, etc 
• Days of the Week: Monday, Tuesday, Wednesday, … 

• Months of the Year: January, February, March, … 
• Counting Numbers: 1, 2, 3, 4, … 

• Odd Numbers: 1, 3, 5, 7, … (Type first two numbers to show the pattern) 
• Multiplication Table: 2, 4, 6, 8, … (for 2 times table) 

 

 

 

 

 

 

 

 

 

 

 



TOPIC: COMPUTER NETWORKS 

Definition of a Network 

A network is a group of two or more computers or devices connected together to share resources, such as 
files, printers, internet, and data. 

 

✅ Explanation of Network 

When computers and other devices (called nodes) are connected by cables, wireless signals, or other means, 
they can communicate with each other. This connection is called a network. 

🔄 Why Networks Are Important: 

• ✅ Share files and data easily 

• ✅ Access shared printers and hardware 

• ✅ Use one internet connection for many devices 

• ✅ Communicate through emails, chats, and video calls 

 

Key Hardware Components in Network Systems 

Before diving into the topologies, it's important to understand the hardware commonly used in network 
setups: 

• Server: A powerful computer that provides services or resources to other computers (clients) in the 
network. 

• Client: A computer or device that accesses services provided by a server. 
• Hub: A basic networking device that connects multiple computers in a network, broadcasting data to 

all connected devices. 
• Switch: An advanced device that connects devices in a network and uses MAC addresses to forward 

data only to the intended recipient. 
• Router: A device that connects different networks together and directs data between them. 

• Cable: Physical wires (like Ethernet cables) used to connect devices in a network.  

 

🌐 Network Topologies 

Definition of Network Topologies 

Network topology is the logical or physical arrangement of computers, devices, and cables in a network. 
It shows how devices are connected and how data flows between them. 

Topologies include the following: 

1. Bus Topology – All devices share one main cable. 

2. Star Topology – All devices connect to a central hub or switch. 
3. Ring Topology – Each device is connected to two others, forming a ring. 

4. Mesh Topology – Every device is connected to every other device. 
5. Tree Topology – Groups of star networks connected to a main bus cable. 



6. Hybrid Topology – Combination of two or more different topologies in one network. 

 

1. Bus Topology 

Bus topology is a type of network where all devices are connected to a single central cable, 

called the bus or backbone. 

 

Features: 

• Single Backbone: All devices are connected to a single central cable, known as the bus or backbone. 
• Data Transmission: Data sent from a device travels in both directions to all devices until it reaches 

the intended recipient. 
• Terminators: Both ends of the bus have terminators to prevent signal bounce. 

• Advantages: 
o Easy to implement and extend. 

o Requires less cable length than some other topologies. 
• Disadvantages: 

o If the main cable fails, the entire network goes down. 
o Difficult to troubleshoot. 

 

2. Star Topology 

Star topology is a type of network where all devices are connected to a central device, such as a hub or 
switch. 



 

 

Features: 

• Central Connection Point: All devices are connected to a central device (hub or switch). 

• One-to-One Connection: Each device has its own separate cable connected to the central point.  
• Data Flow: Data sent from one device goes to the hub/switch, which then forwards it to the correct 

destination. 

 

Advantages: 

• ✅ Easy to manage – It’s simple to add or remove devices. 

• ✅ Problem isolation – If one cable or device fails, the rest of the network is not affected. 

• ✅ High performance – Especially when using a switch, data is sent directly to the right device. 

 

Disadvantages: 

• ❌ Central point of failure – If the hub or switch fails, the whole network goes down. 

• ❌ More cable needed – Requires more cable length than bus topology, which can be expensive. 

 



3. Ring Topology 

Ring topology is a type of network where each device is connected to two other devices, forming a 
circular path for data to travel. 

 

 

Features: 

• Circular Connection: Devices are connected in a loop or ring shape. 

• Data Flow: Data travels in one direction (or in both directions in a dual ring) around the circle until 
it reaches the correct device. 

• No Central Hub/Switch: Unlike star topology, it does not need a central device. 

 

Advantages: 

• ✅ Equal access to network: Each device has equal chance to send data. 

• ✅ Organized flow of data: Data travels in one direction, reducing collisions. 

• ✅ Performs well with many devices if the network is small or medium-sized. 

 

Disadvantages: 



• ❌ One failure affects all: If one device or cable breaks, the whole network can stop working. 

• ❌ Harder to troubleshoot: Finding the problem in the ring can be difficult. 

• ❌ Adding or removing a device can disrupt the entire network. 

 

4. Tree Topology 

Tree topology is a combination of star and bus topologies. It has a root node (main computer or device) at 

the top, and branches out like a tree. Each branch can have a hub or switch that connects multiple devices. 

 

 

🔹 Characteristics of Tree Topology 

• Hierarchical structure – like a tree with roots and branches. 

• Combines the flexibility of star topology and simplicity of bus topology. 
• Devices are connected in groups (clusters), and each group connects to a central backbone cable. 

 

✅ Advantages of Tree Topology 

• Easy to expand the network. 
• Allows grouping of devices for better management. 

• Faults in one branch do not affect the entire network. 
• Suitable for large organizations with different departments. 

 

⚠️ Disadvantages of Tree Topology 

• Uses a lot of cables, making it expensive. 
• If the backbone cable fails, the whole network goes down. 

• Difficult to troubleshoot and manage in large setups. 

 

 



5. Mesh Topology 

Mesh topology is a network setup where each device (node) is interconnected with multiple other devices in 

the network, creating redundant paths for data transmission. This results in high fault tolerance and 
reliability, as data can find alternative routes if one connection fails. However, it can be more complex and 

expensive to implement than other topologies like star or bus. 

 

 

Key characteristics of mesh topology: 

Redundancy: Multiple connections between nodes ensure that data can be transmitted even if some 

connections fail.  

Fault tolerance: If one path is unavailable, the network can reroute traffic through other available paths.  

Decentralized: There isn't a single point of failure (like a central hub in a star topology).  

High reliability: The ability to reroute data makes mesh networks very reliable for critical applications.  

Cost: Full mesh topologies (where every device connects to every other) can be expensive to implement due 
to the number of connections and cabling required. 

Types of Mesh Topology 

Full Mesh: Each device is connected to every other device in the network.  

Partial Mesh: Some devices are connected to multiple other devices, but not all, offering a balance between 

redundancy and cost. 

Advantages 

• High reliability: Multiple paths minimize the impact of connection failures.  

• Fault tolerance: The network can continue operating even with some broken links.  

• Scalability: Easy to add new nodes without disrupting existing connections. 

 

Disadvantages 

Cost: More expensive to implement than other topologies due to the need for more hardware and cabling.  

Complexity: Setting up and managing a mesh network can be more complex than other topologies.  

Potential for redundancy: Redundant connections can sometimes lead to wasted resources. 

6. Hybrid Topology 

Hybrid topology is a combination of two or more different network topologies such as star, bus, ring, or 
mesh in a single network. 



 
It is used when different departments or sections of an organization use different topologies, and they need 

to be connected in one larger, unified network. For example, one department may use a star topology while 
another uses a ring, and both are linked together. This forms a hybrid network. 

 

 

Features of Hybrid Topology 

• Combines the strengths of two or more topologies. 

• Flexible and scalable. 
• Supports a large number of devices and network structures. 

• Used in large organizations and enterprise networks. 

 

Advantages 

1. Reliable – If one part of the network fails, the rest can continue to function. 

2. Flexible – Easy to add or remove devices or entire sections. 
3. Efficient – Can be designed to meet the specific needs of different departments. 

4. Scalable – Suitable for expanding large networks. 

 

Disadvantages 

1. Expensive – More cables and hardware are needed, increasing cost. 

2. Complex Setup – Difficult to design, install, and manage. 
3. Maintenance Difficulty – Troubleshooting can be complicated due to mixed topologies. 

 



Types of Networks 

Types of network include: 

1. PAN (Personal Area Network) 
2. LAN (Local Area Network) 

3. MAN (Metropolitan Area Network) 

4. WAN (Wide Area Network) 
5. WLAN (Wireless Area Network) 

6. Internet 

 

1. Personal Area Network (PAN) 
A PAN is a small network used to connect personal devices within a short range, typically a few meters. It 

allows communication between devices like phones, laptops, and wireless headsets using technologies like 
Bluetooth.                                                                                                                                                 
Example: Connecting a smartphone to a wireless headset using Bluetooth. 

2. Local Area Network (LAN) 

A LAN is a network that connects computers and devices within a limited area such as a home, school, or 
office. It is commonly used for sharing files, printers, and internet.                                            
Example: A school computer lab where all computers are connected to a central server. 

3. Metropolitan Area Network (MAN) 

A MAN is a network that connects multiple LANs within a city or town. It is used to link offices, campuses, 
or government buildings spread across a metropolitan area.                                                                    
Example: A university with several campuses in a city connected through a central network. 

4. Wide Area Network (WAN) 

A WAN is a large network that connects computers and smaller networks across long distances, such as 
from city to city or country to country. The internet is the largest example of a WAN.                                  
The internet links computers and networks all over the world.                                                  

5. Wireless Local Area Network (WLAN) 

A WLAN is a type of LAN that connects devices wirelessly using Wi-Fi technology. It allows devices to 
communicate and access the internet without physical cables.                

Example; Using Wi-Fi at home to connect your phone, laptop, and smart TV to the internet. 

 

What is Networking? 

Networking is the process of connecting two or more computing devices (like computers, phones, or 
printers) so they can share information and work together. 

 

Professions and Business Opportunities in Networking 

• Network Administrator: A person who manages computer networks in places such as schools, 

offices, and hospitals. They make sure all the computers are connected and working properly. 
• Network Engineer: This person designs and builds networks. They help connect computers in 

different buildings or even in different towns. 
• IT Support Technician: A person who helps people solve problems with their computers and 

networks. For example, if the internet is not working, they fix it. 



• Wireless Network Installer: This person sets up Wi-Fi in homes, hotels, schools, and offices. They 
help people connect their phones and laptops to the internet without using cables. 

• Cybersecurity Officer: A person who protects networks from hackers and viruses. They make sure 
that the information on computers is safe and secure. 

• Network Cable Installer: This person lays and connects cables that allow computers and devices to 
share information. They work in schools, banks, offices, and other places. 

• Internet Café Operator: A person who runs a business where people pay to use computers and 
browse the internet. The café may also offer services like printing, typing, and playing games. 

• Networking Teacher or Trainer: A person who teaches others how to build and manage networks. 
They may teach in schools or run private training classes. 

 

Business Opportunities in Networking 

• Starting a business to install internet in homes, schools, and offices. 
• Selling network equipment like routers, cables, switches, and modems. 

• Offering repair and support services for computer networks. 
• Opening an internet café for public use. 

• Teaching networking skills to students and workers. 

 

INTERNET AND SOCIAL MEDIA 

Social media sites are online platforms that allow people to create, share, and exchange information, 

messages, pictures, and videos. They are used for communication, learning, entertainment, and business. The 
main types of social media include social networking sites, microblogging platforms, media sharing 

sites, discussion forums, and collaborative platforms. 

 

1. Social Networking Sites 

These platforms are used for connecting with friends, family, classmates, or co-workers. Users can create 

profiles, chat, share updates, photos, and videos. 

• Facebook – Used to connect with others, post pictures, share news, and join groups. 

• WhatsApp – A messaging app for chatting, making calls, and sharing files. 
• LinkedIn – A platform for professionals to connect, look for jobs, and build work networks. 

• Telegram – Similar to WhatsApp, used for fast and secure messaging and sharing content. 
• Snapchat – Allows users to send disappearing photos and videos, popular among young people.  

 

2. Microblogging Platforms 

These platforms allow users to share short posts or updates, often with a word limit. Posts may include text, 
photos, links, or videos. 

• Twitter (now called X) – Used to share short messages called tweets, follow news, and interact with 
people. 

• Tumblr – Allows users to post short blogs, images, GIFs, and videos. Popular among creative users. 
• Threads – A newer platform used for sharing short messages and thoughts, similar to Twitter. 



 

3. Media Sharing Sites 

These platforms are mainly for uploading and sharing photos, videos, and music. 

• YouTube – Used to watch and share videos. People also earn money by creating videos. 

• Instagram – Used to share photos and short videos (reels), with followers and friends. 
• TikTok – A platform for creating and watching short videos, mostly used for entertainment. 

 

4. Discussion Forums 

These are websites where users ask questions, share ideas, and discuss topics of interest.  

• Reddit – A forum where people discuss different topics in communities called subreddits.  

• Quora – A question-and-answer platform where users post questions and get answers from others.  

 

5. Collaborative and Educational Platforms 

These platforms allow people to work together, share notes, and learn online. 

• Google Classroom – Used by teachers and students for sharing lessons, assignments, and class 
discussions. 

• Edmodo – A learning platform that connects students and teachers for class activities. 
• Microsoft Teams – Used for online meetings, group chats, and class collaboration. 

 

📎 Attachment 

An attachment is a file sent along with an email message, such as a photo, document, or video. It lets you 
share extra information beyond the written message. Many email systems limit attachment sizes (often 

around 25 MB). Add an attachment by clicking the paperclip icon before sending your email.  

 

📇 Address Book 

An address book is your list of saved contacts, including names and email addresses—and sometimes 
phone numbers. Instead of typing each email address manually, you can select a contact from this list. You 

can also create groups to send one message to many people quickly.  

 

📧 Creating, Sending & Receiving Emails 

• Click Compose or New Message to begin. 

• Use To, Cc, and Bcc fields to choose who gets your message. 
• Type a clear Subject so the reader knows what the email is about. 

• Write your message in the main body. 



• Click the paperclip icon to add any file before sending  
• Press Send; incoming messages go to your Inbox automatically. 

 

🔄 Replying & Forwarding 

• Hit Reply to send your answer only to the original sender. 
• Choose Reply All to include everyone listed in To or Cc. 

• Use Forward to send the email content to someone else, adding your own note if needed  

 

🗂️ Using From, To, Cc, Bcc & Subject 

• From shows who sent the email (your address). 
• To is for those expected to read and act on the message. 

o Primary recipients go here. 
• Cc (carbon copy) adds people for their information and lets everyone see who else got it. 

• Bcc (blind carbon copy) sends copies without showing other recipients’ addresses. Good for privacy 
or large lists. 

• Subject gives a short hint about the email, helping the reader know the topic at a glance. 

 

📌 Why Use These Fields 

• From shows who the message is from. 
• To marks who needs to respond or take action. 

• Cc keeps others informed without requiring their response. 
• Bcc protects privacy and avoids long reply-all threads. 

• Subject lets the reader understand the purpose before opening. 

 

✔️ Quick Checklist 

1. Compose → add recipients → add subject → write body → add attachments → send. 
2. Reply/Reply All/Forward based on who needs the message. 

3. Use To for main recipients, Cc to copy others, Bcc for hidden recipients. 
4. Always fill in Subject clearly. 

5. Use address book to save time entering email addresses. 

 

INFORMATION SECURITY 

Information security is the process of protecting information and information systems from being 
accessed, changed, or destroyed by people who shouldn’t do that. It helps ensure that data remains 
private, correct, and available when needed. 

 



Confidentiality  

This is the act of keeping information secret from people who shouldn’t see it. For example, student grades 

or medical records are only meant for teachers or doctors. When someone logs into the school portal, they 
might use a password or code sent to a phone to protect their privacy. Only those who should see the 

information are allowed access. Encryption and special login steps help keep private data safe. 

 

Integrity  

This ensures information stays correct and complete. Imagine sending a school report by email, but it arrives 

with missing pages or errors—that means integrity has failed. Schools and banks use special checks like 
digital signatures or "hashes" to make sure nobody has changed the files without permission. They also keep 

backups so if something gets broken, they can restore it exactly the way it was. 

 

Availability  

This refers to a situation where information and systems are ready and working whenever they are needed. 

For example, students should be able to check their results online, and teachers should be able to access 
lesson materials at any time. To make sure systems are always available, there may be extra servers, backup 

power, and plans for fixing things quickly after problems like storms or power cuts.  

 

When we create things like songs, books, inventions, brand names, or artwork, the law says these belong to 
us. These rights are called Intellectual Property Rights (IPRs). There are four important types: 

1. Copyright 
Copyright covers things you create—stories, songs, pictures, videos, and even software code. Once 

you write or record something, it’s protected by copyright automatically. This means others cannot 
copy, share, or sell it without your permission. Software may be freeware (completely free) or 

shareware (free for trial but needs payment later), while crippleware is software that won’t work 
fully until paid for. Violating copyright can lead to fines or even jail time depending on the country. 

In the U.S., serious cases might result in prison for up to five years and fines up to $250,000  

 

2. Patent 
A patent protects inventions—like new machines, methods, or unique product shapes. Once you hold 

a patent, only you can make, use, or sell that invention for about 20 years. If someone uses your 
invention without your permission, it’s called infringement, and they may be taken to court and 

forced to stop or pay damages. 

 

3. Trademark 
A trademark includes brand names, logos, slogans, or symbols—like Coca-Cola’s name or the Nike 

swoosh. These marks show who made a product. Using another person’s trademark without 
permission can confuse customers and is illegal. Consequences include being ordered to stop, fined, 

and paying damages; serious cases may even involve criminal penalties. 

 



4. Piracy and Counterfeiting 
Piracy is illegally copying and sharing creative works like movies, songs, and games. Counterfeiting 

is making and selling fake goods with real brand names (e.g., fake designer bags). Both are serious 
crimes. Pirates can face criminal charges, heavy fines, or imprisonment (up to 10 years in some 

countries); counterfeiters may lose their goods and be fined or jailed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

BASIC EIGHT (8) 

 

 

 

 

 

 

 

 

 

 

 

Negative Impacts of Computers and Computer Use 

• E-Waste: Discarded electronics like computers add to e-waste, which contains toxic substances 
(such as lead, mercury) that can pollute soil and water if not disposed of properly. 

• Energy Consumption: Computers, servers, and data centers require a large amount of electricity, 
often from fossil fuels, which increases gas emissions and contributes to climate change.  

• Resource Depletion: Manufacturing computers involves mining valuable materials (e.g., gold, 
copper), leading to deforestation, pollution, and depletion of non-renewable resources. 

• Pollution from Manufacturing: The production of computers releases harmful chemicals and 
greenhouse gases into the environment, which can affect air and water quality. 

• Health Problems: 

• Eye Strain: Prolonged screen time can cause eye discomfort and blurred vision. 

• Posture Issues: Long hours at a computer can lead to poor posture, resulting in neck and back pain.  

•  



Environmentally Responsible Practices To Minimize Negative Impacts Of Computers  

• Avoid Paper Waste: Go paperless and print only when necessary to reduce paper consumption. 
• Reduce Energy Consumption: Turn off devices when not in use and use energy-efficient settings. 

• Dispose of E-Waste Responsibly: Recycle electronics properly or donate functional devices when 
not needed. 

• Upgrade Instead of Replacing: Upgrade components or repair devices to extend their lifespan. Eg. 
Buy new RAM with larger size. 

• Use Longer-Life Devices: Invest in durable, high-quality computers that last longer, reducing the 
need for frequent replacements.  

• Use Laptops and tablets in optional cases instead of Desktop to save power.  

 

TOPIC: HEALTH PROBLEMS ASSOCIATED WITH REGULAR USE OF 

COMPUTERS 

Eye Strain (Computer Vision Syndrome) 

• Symptoms: Dry eyes, blurred vision, headaches, neck and shoulder pain. 
• Preventive Measure: Follow the 20-20-20 rule (every 20 minutes, look at something 20 feet away 

for 20 seconds), adjust screen brightness, use artificial tears, and ensure proper screen placement at 

eye level. 

 

Posture Problems 

• Symptoms: Neck, back, and shoulder pain, stiffness, discomfort, and reduced flexibility. 
• Preventive Measure: Sit with feet flat on the floor, keep the screen at eye level, and use an 

ergonomic chair. Take regular breaks to stand and stretch. 

 

Repetitive Strain Injuries (RSI) 

• Symptoms: Pain, numbness, tingling, and weakness in the wrists, elbows, or shoulders. 

• Preventive Measure: Use an ergonomic keyboard and mouse, take breaks to stretch hands and 
wrists, and maintain proper wrist positioning while typing. 

 

Fatigue 

• Symptoms: Reduced focus, irritability, difficulty concentrating, and stress. 

• Preventive Measure: Take regular breaks, practice mindfulness, avoid multitasking, and ensure a 
healthy work-life balance. 

• Stress 

• Symptoms: Increased anxiety, irritability, headaches, muscle tension, and difficulty relaxing. 
• Preventive Measure: Manage screen time effectively, practice relaxation techniques such as deep 

breathing, take regular breaks, and engage in physical activities to reduce stress levels. 

 

 



 

 

 

 

PRODUCTIVITY SOFTWARE 

TOPIC: INTRODUCTION TO WORD PROCESSING 

Word Processor 

• A word processor is a software application or program designed to create, edit, format, and print text-based 

documents.  
• It provides tools for writing and organizing text while enabling the user to enhance the document with features 

such as formatting styles, images, tables, and other graphical elements. 

 

Ribbon 

• The Ribbon is the top section of the MS Word interface that organizes tools and commands into tabs and 

groups for easy access.  

• It includes functionalities for formatting, inserting objects, reviewing, and more. 

Quick Access Toolbar 

• Located above or below the Ribbon, the Quick Access Toolbar provides shortcuts to frequently used 

commands like Save, Undo, and Redo. It can be customized to include additional commands. 

Tabs 

• Tabs are sections within the Ribbon (e.g., Home, Insert, Design) that categorize commands based on their 
functionality.  

• Tabs are arranged horizontally at the top of the ribbon. 

• Clicking on a tab reveals related groups and commands. 

Title bar 

• The Title Bar is located at the very top of the Word window. It displays the name of the document and the 

program (e.g., Document1 - Microsoft Word).  

• It also houses the Minimize, Maximize, Restore, and Close buttons (Control Box). 

 

Understanding Document Orientation and Margins 

In Microsoft Publisher, adjusting the orientation and margins helps improve the layout and readability of 
your publication. 

1. Document Orientation 

• Definition: Orientation refers to the way a publication is displayed or printed on a page.  
• Types of Orientation: 

o Portrait: The height is greater than the width. 
o Landscape: The width is greater than the height. 



• Steps to Change Orientation in Publisher: 
1. Open your publication. 

2. Click on the "Page Design" tab. 
3. Select "Orientation" in the Page Setup group. 

4. Choose either Portrait or Landscape. 

2. Document Margins 

• Definition: Margins are the empty spaces around the edges of a page that keep content from reaching 

the borders. 
• Steps to Change Margins in Publisher: 

1. Click on the "Page Design" tab. 
2. Select "Margins" in the Page Setup group. 

3. Choose a pre-set margin or click "Custom Margins" to set specific values. 
4. Click OK to apply changes.  

1. Adding Pictures to a Publication 

Pictures enhance the visual appeal of a publication. In Microsoft Publisher, you can add images from 

different sources such as your computer, online sources, and clip art.  

Steps to Add Pictures 

1. From Your Computer: 

o Click on the "Insert" tab. 
o Select "Pictures" and choose "This Device". 

o Browse and select an image, then click "Insert". 
2. From Online Sources: 

o Click on the "Insert" tab. 
o Select "Online Pictures". 

o Search for an image using Bing or OneDrive. 
o Select an image and click "Insert". 

2. Modifying Pictures 

Once an image is inserted, you can modify it using various tools in Publisher.  

Basic Editing Options: 

• Resize: Click on the image and drag the corner handles to enlarge or reduce the size while 
maintaining proportions. 

• Crop: 
1. Select the picture. 

2. Click "Picture Format"  
3. Click on "Crop". 

4. Adjust the cropping handles to remove unwanted parts. 
• Rotate: 

o Click the rotation handle at the top of the picture and drag to rotate. 
• Move: 

o Click and drag the picture to a new location. 

Applying Picture Effects: 

• Adjust Brightness & Contrast: Go to "Picture Format" > "Corrections" and choose a preset. 

• Apply Artistic Effects: Click "Picture Format" > "Artistic Effects" and select a style. 
• Add Borders: Click "Picture Border" to add a frame around the image. 



• Recolor: Use the "Color" option to adjust the image tone. 

1. Adding Text to a Publication 

Microsoft Publisher allows users to add and format text using text boxes. 

Steps to Add Text: 

1. Click on the "Insert" tab. 

2. Select "Draw Text Box" in the Text group. 
3. Click and drag to create a text box in the desired location. 

4. Type your text inside the box. 

2. Modifying Text 

Once text is added, you can modify it using various formatting options. 

Basic Text Formatting: 

• Change Font: Select the text and choose a font from the "Home" tab. 

• Change Font Size: Select the text and increase or decrease the font size. 
• Apply Bold, Italic, or Underline: Click the respective buttons (B, I, U) in the Home tab. 

• Change Text Color: Click "Font Color" and select a color. 

Advanced Text Modifications: 

• Align Text: Use Left, Center, Right, or Justify alignment options. 

• Adjust Line Spacing: Click "Line Spacing" to modify the spacing between lines. 
• Use Bullets and Numbering: Click "Bullets" or "Numbering" for lists. 

• Apply WordArt Styles: Click on "Insert" > "WordArt" to add decorative text. 

Modifying Text Box Properties: 

• Resize a Text Box: Click and drag the handles to adjust size. 

• Move a Text Box: Click inside the box and drag it to a new location. 
• Rotate a Text Box: Click and drag the rotation handle at the top of the box. 

• Change Text Box Fill and Border: Use the "Format" tab to add colors or borders 

 

Topic: SPREADSHEET APPLICATION 

Definition of a Spreadsheet Application 

A spreadsheet application is a software program used to store, organize, analyze, and manipulate data in a 
tabular format. It consists of rows and columns that form cells where users can input text, numbers, and 

formulas. Spreadsheet applications are commonly used for tasks such as financial analysis, budgeting, data 
visualization, and record-keeping. 

Some common examples of spreadsheet applications include: 

• Microsoft Excel 

• Google Sheets 
• Lotus 1-2-3 

• LibreOffice Calc 
• Apple Numbers 

• Zoho Sheet 



 

Terminologies 

• Cell(s): The intersection of row and column forms a cell. It is the smallest unit in a spreadsheet 
where data is entered, identified by a column letter and row number (e.g., A1, B5).  

• Rows: Horizontal arrangements of cells in a spreadsheet, labelled with numbers (1, 2, 3…). Rows 
begin with 1 and end at 1048576. 

• Columns: Vertical arrangements of cells, labelled with letters (A, B, C…). Columns begin with A up 
to XFD. 

• Worksheet: This is a single sheet within a spreadsheet application containing rows and columns for 
data entry and analysis. 

• Workbook: This is a collection of worksheets within a single spreadsheet file.  
• Active Cell: The currently selected cell in a worksheet, usually highlighted with a border. 
• Cell Address (Reference): The unique identifier of a cell, based on its column letter and row 

number (e.g., A1, C5). 
• Formula: This is a mathematical expression entered in a cell to perform calculations or operations 

(e.g., = A1 + B2 + B3). 
• Function: A predefined formula in a spreadsheet that performs calculations (e.g., SUM(), 

AVERAGE()). 
• Arguments: refers to the values or references passed into a function to perform a specific calculation 

or operation. Arguments are enclosed in parentheses and can be numbers, text, cell references, 

ranges, or other expressions. Text must be in double quotes (“ ”) when used as an argument. 
• Name Box: The area that displays the address of the active cell. 
• Sheet Tab: The tab at the bottom of the workbook that allows switching between different worksheets. 
• Quick Access Toolbar: A customizable toolbar that provides quick access to frequently used 

commands like Save, Undo, and Redo. 
• Ribbon (Menu Bar): A collection of tabs and command groups that provide access to various 

spreadsheet tools and functions. 
• Scroll Bars: Used to navigate horizontally or vertically through a large worksheet.  
• Row and Column Headers: Numbered rows (1, 2, 3…) and lettered columns (A, B, C…) that help 

identify cell locations. 

 

FUNCTIONS AND FORMULAS 

Formula 

A formula is an equation manually created by the user in a spreadsheet to perform calculations. A formula 
can use *cell references, numbers, operators (e.g., +, -, * , /), and functions. Every formula starts with an 

equal sign (=). 

Example: 

• =A1 + A2 + A3 → Adds values in A1, A2, and A3. 
• =B1 * 10 → Multiplies the value in B1 by 10. 
• =(C1 + C2) / 2 → Finds the average of C1 and C2 without using a function.  

 

Function 

A function is a predefined formula in a spreadsheet application that performs calculations or operations on 
data. Functions take one or more inputs (called arguments) and return a result. 

Examples: 

SUM() – This function adds values in a specified cells. Eg. = SUM(A1:A10) 

PRODUCT() – This multiplies values in specified cells. Eg. =PRODUCT(B2,C2) 



AVERAGE() -This function automatically calculates the average of numbers in specified cells. Eg. 
=AVERAGE(C2:C10) 

TODAY() – Returns the current date. 

DAY(A1) – Extracts the day from a given date in cell A 

MONTH(A1) – Extracts the month from a given date. 
YEAR(A1) – Extracts the year from a given date. 

SUMIF(range, condition, [sum_range]) – Adds numbers in a range that meet a condition.  

ROUND(value, decimals) – Rounds a number to a specified number of decimal places. 

COUNT(range) – Counts numeric values in a range. 

COUNTA(range) – Counts all non-empty cells (both numbers and text).  
COUNTIF(range, condition) – Counts cells that meet a condition. 

PROPER(text) – Capitalizes the first letter of each word.  
UPPER(text) – Converts text to uppercase. 
LOWER(text) – Converts text to lowercase. 
CONCATENATE(text1, text2, ...) – Joins multiple text strings together.  

RIGHT(text, [num_chars]): Returns the specified number of characters from the end of a string. 

Example: RIGHT("Hello", 2) returns "lo". 

LEFT(text, [num_chars]): Returns the specified number of characters from the start of a string. 

Example: LEFT("Hello", 2) returns "He". 

MID(text, start_num, num_chars): Returns the specified number of characters from the middle of a string, 
starting at a position you define. 

Example: MID("Hello", 2, 3) returns "ell". 

IF(condition, value_if_true, value_if_false) – Checks a condition and returns different values based on the result. 
AND(condition1, condition2, ...) – Returns TRUE if all conditions are met. 
OR(condition1, condition2, ...) – Returns TRUE if at least one condition is met. 
IFERROR(expression, value_if_error) – Returns an alternate value if an error occurs. 

=IF(AND(A1>=50, B1>=50), "Pass", "Fail")  

=IF(OR(A1>=50, B1>=50), "Pass", "Fail")  

 

 

SECTION:  COMMUNICATION NETWORKS 

TOPIC: COMPUTER NETWORKS 

What is a Data Communication Model? 

A data communication model is a system or structure that explains how data is sent and received between 
two or more devices (like computers or phones) over a network. 

It shows how information flows, the rules to follow, and the steps involved in making communication 
successful. 



There are basically Two (2) types of Data Communication Models. They include:

 

1. OSI Model (Open Systems Interconnection Model) 
2. TCP/IP Model (Transmission Control Protocol/Internet Protocol Model) 

 

1. The Open System Interconnection (OSI) Model 

The OSI model is a standard model created to help different devices from different companies communicate 
properly on a network. 

It breaks communication into 7 layers, each with a special job. 

Example: When you send a message online, it goes through the 7 layers, one after the other. 

 

2. The 7 Layers of the OSI Model 
 

Layer                           Purpose  

• Application Layer – Allows users to interact with the network through software like browsers and email 

apps. 

• Presentation Layer – Translates, encrypts, or compresses data for the application layer  

• Session Layer – Manages the start and end of communication between two devices. 

• Transport Layer – Makes sure data is sent completely and correctly. 

• Network Layer – Decides the best path to send data from one device to another. 

• Data Link Layer – Breaks data into frames and checks for errors in transmission. 

• Physical Layer – Sends data as electrical signals through cables or wireless waves. 
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4. Purpose / Benefits of the OSI Model Layers 

• ✅ Makes communication easier: Each layer has a specific task, which keeps things organized. 

• ✅ Enables different devices work together: Devices from different companies can communicate 

if they follow the OSI rules. 

• ✅ Makes troubleshooting easier: When there’s a problem, it's easier to find and fix it by checking 

each layer. 

• ✅ Supports growth and upgrades: You can improve one layer without changing the whole 

system. 

 



 

3. TCP/IP Model (Transmission Control Protocol/Internet Protocol Model) 

The TCP/IP model is the main model used for communication on the Internet. It shows how data moves 
from one device to another across a network. 

It was developed by the U.S. Department of Defence and is based on real-world networking. 

 

Layers of the TCP/IP Model 

The TCP/IP model has 4 layers. Each layer has its own job in helping data move safely and correctly.  

Layer Purpose 

1. Application Layer Allows users to interact with network services like websites, email, and file sharing. 

2. Transport Layer 

 

Makes sure the data arrives complete and in order (uses TCP or UDP) 

 

3. Internet Layer Finds the best route for the data to travel across different networks (IP addressing). 

1. Network Access Layer Deals with how data is physically sent over the network (e.g. cables, Wi-Fi). 
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Purpose / Benefits of the TCP/IP Model 

• ✅ Used in real networks, especially the Internet. 

• ✅ Faster and simpler than the OSI model. 

• ✅ Helps computers find each other and send data correctly. 

• ✅ Supports many types of applications, like web browsing, emails, and video calls. 

 

Summary: 

• The TCP/IP model is the real-world model used for Internet communication. 

• It has 4 layers, each handling part of the communication process. 
• It helps devices connect and exchange data efficiently. 

 

The Internet 

The Internet is a global network of interconnected computers that communicate using standard protocols. It 
allows people to send and receive information, access websites, send emails, stream videos, and connect 

through social media from anywhere in the world. 

• It is not owned by any single person or organization. 

• It uses TCP/IP (Transmission Control Protocol / Internet Protocol) to send and receive data. 



 

Brief History of the Internet 

The Internet began in 1969 as a U.S. military research project called ARPANET (Advanced Research Projects 
Agency Network), which connected a few universities to share data. In the 1970s, email was developed and 

TCP/IP was introduced as a standard for communication. By the 1980s, the network expanded and became 

known as the Internet. In 1990, Tim Berners-Lee invented the World Wide Web, making it easier to access 
information through websites. The first web browser was launched in 1993, and public use of the Internet 

grew rapidly. Today, the Internet is a global system used for communication, learning, and business.  

Note: 

• First browser ever: WorldWideWeb (Nexus) – 1990 
• First popular graphical browser: Mosaic – 1993 

 

The World Wide Web (WWW) 

The World Wide Web (WWW) is a system of linked web pages and websites that you can access using 

the Internet. It was invented in 1990 by Tim Berners-Lee. 

It works by using web browsers (like Chrome, Firefox, or Edge) to open websites by entering a web address 
(also called a URL, e.g., www.example.com). The web uses HTTP (Hypertext Transfer Protocol) to 

transfer and display information in the form of text, images, videos, and links. 

 

Internet Domain Name Server (DNS) 

The Domain Name Server (DNS) is like the phonebook of the internet. It helps translate domain names 
(like www.google.com) into IP addresses (like 142.250.191.36), which computers use to locate each other 

on the internet. 

Without DNS, we would have to remember the numerical IP address of every website we want to visit. 

Classes of IP Addresses 

Class Starting Range Range of IP Addresses 

A 1 – 126 1.0.0.0 to 126.255.255.255 

B 128 – 191 128.0.0.0 to 191.255.255.255 

C 192 – 223 192.0.0.0 to 223.255.255.255 

D 224 – 239 224.0.0.0 to 239.255.255.255 (Multicast) 

E 240 – 255 240.0.0.0 to 255.255.255.255 (Experimental) 

127 is reserved. Not assigned to any network. Used for feedback loop 

• Class A has many hosts, good for big networks. 

• Class C is most common for homes and small businesses. 

• Class D and E are not used for normal internet browsing. 

IP Versions 



There are two main versions of Internet Protocol (IP): 

 

1. IPv4 (Internet Protocol version 4) 

• It is the older version of IP. 
• Uses a 32-bit address, written as four numbers separated by dots (e.g., 192.168.0.1). 

• Can support about 4.3 billion unique addresses. 

• Still widely used today, especially in homes and offices. 

 

2. IPv6 (Internet Protocol version 6) 

• It is the newer version, created to replace IPv4. 

• Uses a 128-bit address, written in hexadecimal and separated by colons (e.g., 
2001:0db8:85a3::8a2e:0370:7334). 

• Can support trillions of addresses, solving the problem of address shortage. 
• More secure and efficient than IPv4. 

• IPv6 was introduced because the number of devices needing IP addresses became more than what 
IPv4 could handle. 

Difference Between IPv4 and IPv6 

IPv4 IPv6 

32-bit address 128-bit address 

Written in decimal (e.g., 192.168.1.1) Written in hexadecimal (e.g., 2001:0db8::1) 

Has about 4.3 billion addresses Has a much larger number of addresses (340 undecillion) 

Commonly used today Slowly replacing IPv4 to solve address shortage 

Uses dot (.) separators Uses colon (:) separators 

 

Difference Between Internet and World Wide Web (WWW) 

Internet World Wide Web (WWW) 

A global network that connects millions of 
computers 

A system of interlinked web pages and websites 

It is the infrastructure (hardware + network 

system) 

It is a service that runs on the internet 

Includes many services like email, FTP, VoIP, and 

the web 

Only includes websites, web pages, and web 

applications 

Can exist without the World Wide Web Cannot exist without the Internet 

Accessed using many tools (e.g., email apps, 

browsers) 

Accessed mainly using web browsers (e.g., Chrome, 

Firefox) 

 



Topic: INTRODUCTION TO SOCIAL MEDIA AND DIGITAL 

COMMUNICATION TOOLS 

Social Media refers to websites and applications that enable users to create and share content or to 
participate in social networking. These platforms play a major role in communication, entertainment, 

education, marketing, and business. 

Digital Literacy means having the skills to effectively and responsibly use digital technologies to find, 

evaluate, create, and communicate information. It includes knowing how to use devices, online platforms, 
and software applications. 

 

1. Types of Social Media Sites 

1. Photo Sharing Sites 

Platforms where users upload and share photos, often with captions, hashtags, and comments: 

• Instagram – Focuses on images and short videos; includes Stories and Reels. 

• Snapchat – Sends temporary photos and videos; includes filters and chat features. 
• Pinterest – Allows users to discover and “pin” images and links on boards based on interests like 

recipes, fashion, or crafts. 

2. Video Sharing Sites 

Platforms where users upload, stream, or broadcast video content: 

• YouTube – The largest platform for video sharing; supports channels, subscriptions, and live 
streaming. 

• Facebook Live – A feature within Facebook for broadcasting live video to followers. 
• Periscope (discontinued, but previously used for live streaming on Twitter).  

• Vimeo – A video-sharing site favored for high-quality, artistic content. 

3. Social Networking Sites 

Sites that focus on building relationships, communicating, and sharing status updates: 

• Facebook 

• Twitter (now X) 
• LinkedIn 

4. Messaging Platforms 

Used for direct communication, often including file and media sharing: 

• WhatsApp 

• Telegram 
• Messenger 

 

2. Use of Photo Sharing Sites 

Photo sharing platforms are used to: 



• Express creativity through images, stories, and filters. 
• Share life updates with friends and followers. 

• Promote businesses and brands visually (e.g., product photography). 
• Build communities based on shared interests (e.g., photography, crafts, travel). 

• Educate or inspire others with visual content such as infographics, artwork, and step-by-step guides. 

 

3. Use of Video Sharing Platforms 

Video platforms are useful for: 

• Educational content (e.g., YouTube tutorials, lectures). 
• Entertainment (e.g., music videos, skits). 

• Live interaction with audiences during events (e.g., Facebook Live Q&A sessions). 
• Marketing and promotion (e.g., product reviews, explainer videos). 

• News and updates (e.g., short broadcasts, live reporting). 

Demonstration (Example – Uploading a video on YouTube): 

1. Sign in to your YouTube account. 
2. Click the camera icon and select Upload Video. 

3. Choose the video file from your computer. 
4. Add a title, description, and tags. 

5. Choose visibility settings (Public, Private, or Unlisted). 
6. Click Publish. 

 

4. Attaching a Document to an Email (Steps) 

1. Open your email service (e.g., Gmail, Yahoo Mail). 
2. Click Compose to start a new email. 

3. Enter the recipient’s email address, subject, and message. 

4. Click the paperclip icon (📎) or Attach Files. 

5. Choose the file/document from your device. 

6. Wait for the upload to complete. 
7. Click Send. 

Tip: Most services allow attaching multiple files. Avoid very large files, or use cloud links (e.g., Google 
Drive). 

 

5. Clear Explanation Using Conjunctions 

To explain ideas clearly and logically: 

• Use conjunctions such as: 

o Add ideas: and, also, moreover 
o Show contrast: but, however, although 

o Show cause and effect: because, therefore, so 
o Sequence ideas: first, then, next, finally 

Example: 



"Instagram allows users to share photos and videos. It is popular among youth because of its attractive filters 
and interactive features. Although Snapchat also shares photos, it focuses more on temporary messages. 

Therefore, both platforms are useful, but they serve slightly different purposes." 

 

6. Digital Literacy 

Digital literacy includes: 

• Understanding how to use devices (phones, computers, tablets). 
• Navigating the internet safely and effectively. 

• Creating and managing digital content. 
• Recognizing digital threats like scams or cyberbullying. 

• Using productivity tools (e.g., word processors, email, spreadsheets). 

 

7. Societal Issues Raised by Digital Technologies 

Digital technologies raise several issues: 

• Cyberbullying – Harassment or threats made online. 
• Privacy – Misuse of personal information by apps and websites. 

• Addiction – Excessive screen time affecting health. 
• Misinformation – Fake news spread via social platforms. 

• Digital divide – Unequal access to technology based on location or income. 

 

8. Use of the Address Book in Email 

The Address Book or Contacts feature helps users: 

• Store email addresses and names for future use. 
• Group contacts (e.g., Students, Staff, Family). 

• Auto-complete recipient emails when composing. 
• Add details like phone numbers and profile pictures. 

• Share contact cards with others. 

 

INTRODUCTION TO DATA SECURITY THREATS 

🔐 What is Data Security? 

Data security refers to the protection of digital data from unauthorized access, corruption, or theft 

throughout its lifecycle. It ensures that information is confidential, accurate, and available when needed. 

💾 What is a Data Threat? 

A data threat is any potential danger or activity that can compromise the safety, accuracy, privacy, or 

availability of digital information. Threats can be intentional (e.g., hacking) or accidental (e.g., hardware 
failure). 

 



🔍 The Four Major Data Threats 

1. Interruption 

• Definition: Interruption occurs when access to data or a service is temporarily or permanently lost.  
• Nature: The data or system becomes unavailable. 

• Example: 
o A website is shut down due to a power outage. 

o A Denial of Service (DoS) attack makes a server stop responding. 
• Impact: 

o Prevents users from accessing information. 
o Disrupts communication or operations. 

2. Interception 

• Definition: Interception refers to the unauthorized access or eavesdropping of data as it travels across 

a network. 
• Nature: The data is seen or captured by an unauthorized party. 

• Example: 
o Hackers using spyware to read emails or listen to phone calls. 

o Data being stolen during online transactions (man-in-the-middle attacks). 
• Impact: 

o Breach of confidentiality. 
o Leaks of sensitive information like passwords or personal data. 

3. Modification 

• Definition: Modification is when data is altered without permission during storage or transmission. 
• Nature: The original data is changed, possibly leading to incorrect results. 

• Example: 
o A hacker edits exam results in a school database. 

o An attacker changes the amount during a bank transfer. 
• Impact: 

o Leads to misinformation. 
o Damages trust in the data system. 

4. Fabrication 

• Definition: Fabrication is the creation of false data or events in a system without authorization. 
• Nature: Fake information is inserted into the system. 

• Example: 
o Creating a fake user account or login session. 
o Logging non-existent transactions into a database. 

• Impact: 
o Misleads users or systems. 

o Can lead to fraud or misuse of resources. 

 

2. That Prevent Data from Reaching Its Destination 

These are Interruption and Interception: 

• Interruption prevents data from arriving at all. 

• Interception allows the data to arrive, but only after being viewed by unauthorized persons. 



4. Threats That Cause Data Corruption 

Data corruption occurs when digital data becomes damaged, altered, or unreliable, making it inaccurate, 

incomplete, or false. This means the original content of the data is no longer trustworthy. 

Corruption can happen: 

• Accidentally (e.g., power failure, faulty hardware) 
• Deliberately (due to attacks or security threats) 

These are Modification and Fabrication: 

• Modification corrupts the original data by changing it. 

• Fabrication introduces fake data that corrupts the integrity of the system. 

 

INTRODUCTION TO DATA PROTECTION METHODS 

To safeguard data from threats such as Interruption, Interception, Modification, and Fabrication, we use 
specific data protection techniques. These methods help ensure that data remains confidential, accurate, 

and available. 

 

🔐 Key Terms (Definitions) 

Term Definition 
Authorisation The process of giving a user permission to access specific resources or perform certain actions. 

Authentication The process of verifying the identity of a user or system. 
Encryption The process of converting data into a secret code to prevent unauthorized access. 
Decryption The process of converting encrypted data back into readable form. 

 

🧩 Mapping Protection Methods to Data Threats 
Data Threat What it Means Protection Method How it Helps 
Interruption Data or service is made 

unavailable. 
Authorisation Limits access to critical systems, reducing 

chances of accidental or malicious disruption.   
Authentication Ensures only legitimate users can access or 

use the system. 
Interception Unauthorized access to data 

during transmission. 
Encryption & 
Decryption 

Encrypts data so even if intercepted, it 
cannot be read without a decryption key. 

Modification Unauthorized alteration of 
data. 

Authentication Confirms that only trusted users can edit 
data.   

Encryption Protects data from being altered in transit by 
making it unreadable. 

Fabrication Creation of false or fake 
data. 

Authorisation Prevents unauthorized users from injecting 
data into the system.   

Authentication Ensures data entries come from verified 
sources or users. 

 

🔍 Detailed Explanation of Each Mapping 

✅ 1. Interruption — Protected by Authorisation and Authentication 



• Threat: Blocks access to data/services. 
• Solution: 

o Authentication confirms users are who they say they are. 
o Authorisation ensures only permitted users can interact with systems (e.g., shutdown 

servers). 

✅ 2. Interception — Protected by Encryption and Decryption 

• Threat: Data is seen or captured during transmission. 
• Solution: 

o Encryption scrambles data so unauthorized viewers can't understand it. 
o Decryption allows the correct recipient to make sense of the data. 

✅ 3. Modification — Protected by Authentication and Encryption 

• Threat: Data is changed without permission. 
• Solution: 

o Authentication ensures only verified users can alter data. 
o Encryption protects data from being altered mid-transmission. 

✅ 4. Fabrication — Protected by Authentication and Authorisation 

• Threat: Fake data or users are added to the system. 
• Solution: 

o Authentication blocks false identities or fake sessions. 
o Authorisation restricts actions to approved users, preventing false entries. 

 

💡 Exemplar Activities 

1. Brainstorming Activity 

Objective: Students think of ways to protect data in real-life situations. 

• Prompt: “What can be done to stop someone from hacking into a school system or creating fake 

student results?” 
• Expected Responses: 

o Use passwords (Authentication) 
o Limit access to only the headteacher (Authorisation) 

o Use codes or software to scramble data (Encryption) 

2. Matching Activity 

Objective: Students match each data threat with its protection method. 

Threat Method of Protection 
Interruption Authorisation, Authentication 
Interception Encryption and Decryption 

Modification Authentication, Encryption 
Fabrication Authentication, Authorisation 

 

 



WEB TECHNOLOGIES 

Definition: Web Search 

A web search is the process of entering keywords or phrases into a search engine (e.g. Google, Bing, 

Yahoo) to find information online. 

 

✅ Effective Search Techniques 

To get accurate results quickly, use these techniques: 

1. Use Specific Search Phrases 

• Instead of: school project 

• Use: best science project ideas for JHS students 

2. Use Quotation Marks ("") 

• Use quotation marks to search for an exact phrase. 

• Example: 
"how to plant maize step by step" 

3. Use AND 

• Narrows the search by combining keywords. 

• Example: 
farming AND climate change 

4. Use OR 

• Broadens the search by including either term. 

• Example: 
mobile phones OR tablets for students 

5. Use NOT  

• Excludes certain words from the search. 

• Example: 
apple NOT fruit 

or 
apple -fruit 

6. Use Site-specific Search 

• Limits search results to a specific website or domain. 

• Example: 
school curriculum site:nacca.gov.gh 

7. Use Filetype Search 

• Searches for specific types of files (e.g., PDFs, Word docs). 

 



Technique Example Effect 

Quotation Marks "global warming causes" Finds exact phrase 

AND deforestation AND Africa Narrows search to include both terms 

OR education OR training Finds results that mention either term 

NOT or - school -private Excludes the word “private” 

site: results site:waecgh.org Searches only on a specific site 

filetype: ICT notes filetype:pdf Finds PDF documents only 

 

Exploring the Use of More Than One Search Engine 

🔎 What is a Search Engine? 

A search engine is a software system that helps users find information on the internet. 

It uses keywords or phrases (called search strings) to look through millions of web pages and return the 
most relevant results. 

 

💡 Why Use More Than One Search Engine? 

Different search engines may: 

• Display different results for the same search. 
• Use different algorithms to rank websites. 

• Show local or global results depending on their focus. 
• Include ads or sponsored content differently. 

• Offer different filters and features (e.g., images, news, videos). 

 

🔧 Examples of Common Search Engines 

Search Engine Website Features 

Google www.google.com Most popular, fast, wide coverage, smart suggestions 

Yahoo! www.yahoo.com Combines search with news, mail, and more 

Bing www.bing.com Microsoft-owned, rich image/video layout 

DuckDuckGo www.duckduckgo.com Focuses on privacy, does not track users 

Ask.com www.ask.com Question-answer-based search 

 

Importance of Using Multiple Search Engines 

Using more than one search engine helps you: 

• Get broader information 

• Compare results 
• Avoid bias or limitations of one engine 

http://www.google.com/
http://www.yahoo.com/
http://www.bing.com/
http://www.duckduckgo.com/
http://www.ask.com/


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

BASIC NINE (9) 

 

 

 

 



 

 

 

 

 

 

 

 

 

Algorithm 

An algorithm is a step-by-step procedure or set of rules designed to solve a specific problem or perform a 
task. It consists of a sequence of well-defined instructions that take input, process it, and produce an output. 

Ways of Representing an Algorithm: 

1. Natural Language – Describing the steps using human language, though it may be ambiguous.  

2. Pseudocode – A structured, language-independent way of writing an algorithm that resembles 
programming syntax. 

3. Flowchart – A graphical representation using symbols to show the flow of execution. 
4. Programming Code – Writing the algorithm in an actual programming language like Python or 

C++. 

Each representation has its own advantages, depending on the level of clarity and detail required. 

Symbol Name Meaning 
 

Oval  

 

Terminator (Start) Represents the Start or End of a flowchart. 

Parallelogram 
 

 
 

Input/Output Used for input (e.g., user data) and output (e.g., displaying results). 

Rectangle 

 

 

Process Represents a step in the process, such as calculations or assignments. 

Diamond 

 

 

Decision Used for decision-making (Yes/No, True/False) conditions. 

Arrow 
 

 

Flowline Shows the direction of the flow from one step to another. 

 

Flowchart to Determine Whether a Number is Even or Odd 



 

 

 

 

 

 

 

 

 

  

 

 

Start 

Input Number 

Is Number % 2 

== 2 

Display “Even” 

Display “Odd” 


